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Deploying and conf iguring a 
PrintWhere environment

PrintWhere® is a universal Windows print driver that lets users print to any PrinterOn 
registered printer to which they have access directly from any Windows application, 
simply by selecting File > Print. 

To simplify the print setup process for Windows users, administrators can deploy, install, 
and configure PrintWhere and any other necessary printers or drivers on users’ machines. 

This guide outlines a series of tasks that use standard Windows Group Policy or Intune 
features to deploy a common print configuration to users within your organization. This 
deployment process is invisible to the user; once the deployment has been configured, 
the files and software are automatically installed when the user logs in and are ready for 
use with no user intervention at all.

When the user selects File > Print to print a document, they will automatically be printing 
through the PrinterOn service to the default printer you configured for them. 
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The deployment process
Successfully deploying a common print configuration to a group of users involves the 
following set of high-level tasks. Depending on your needs, some of these tasks my be 
optional. 

1. Preparing for deployment: Outlines the prerequisites needed before deployment 
can be considered, and provides some additional information to help you decide 
how best to deploy a print configuration for your situation. 

2. Deploying printers and printer drivers: Describes how to create a Group Policy 
Object specific printer drivers to users. This task is only required if the default 
printer drivers installed with the PrintWhere software don’t meet your needs. 

3. Deploying the PrintWhere software using the method of your choice:
• Deploying the PrintWhere software using Intune: Describes how to use 

Microsoft Intune to deploy and install PrinterOn’s PrintWhere Universal printer 
driver and the PrintWhere configuration file. 

• Deploying the PrintWhere software using Group Policy: Describes how to 
create a Group Policy Object to deploy and install PrinterOn’s PrintWhere 
Universal printer driver and the PrintWhere configuration file. 

Additional configuration information
In addition to the deployment tasks above, this guide includes additional information you 
can use to optimize the performance of PrintWhere and the PrinterOn service. 

• Best practices for configuring PrinterOn for use with PrintWhere: Describes some 
tips and tricks you can use when configuring your PrinterOn service’s printer 
listings. 

• Creating a PrintWhere configuration file: Describes how to create the 
configuration file which you can deploy with the PrintWhere software. 

• Managing PrinterOn plugins: Describes how PrintWhere uses helper objects to 
enable the host computer to locate and connect to printers and what 
administrators need to do to ensure PrintWhere can access these objects to 
enable users to print. 

• Configuring PrintWhere for Citrix and shared terminal environments: Describes 
configuring PrintWhere in those unique use cases where multiple users are 
accessing print services through a single server or terminal. 
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Preparing for deployment

Before beginning the process of setting up the deployment of printers and PrintWhere, it’s 
helpful to ensure that your administration server is properly set up and any required files 
to be deployed are available on the administration computer. 

• Deployment method: Microsoft Intune vs Group Policy
• Active Directory prerequisites
• Availability of files to be deployed to users

Deployment method: Microsoft Intune vs Group Policy
Software can be deployed to Windows computers using one of two methods:

• Microsoft Intune: Intune is Microsoft’s Mobile Device Management software, but 
can be used to manage computers as well as Windows-based mobile devices. 
The Microsoft Intune client is available natively on devices running Windows 10. 
For all other Windows devices, the Intune client must be installed. For information 
on installing the client, see Preparing to use Microsoft Intune: Installing the Intune 
client on users’ devices.

• Windows Group Policy: Group Policy is Windows’ original system designed for 
use in an Active Directory environment. It can be used for central management 
and configuration of user settings, applications, and OS for all computers 
connected to a corporate network.
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Preparing to use Microsoft Intune: Installing the Intune client on users’ 
devices

To allow administrators to remotely deploy and manage software, Microsoft Intune 
requires that a client service be present on the end user’s device. The Intune client is 
available natively on all devices running Windows 10. However, for devices running an 
earlier version of Windows, the Intune PC client must be downloaded and installed. 

To install the Intune client software on users’ devices:
1. Open and log into the Microsoft Azure administration console.
2. In the Intune console, click Admin > Client Software Download. The Client 

Software Download page appears. 

3. Follow the instruction on the page to prepare for, download, and deploy the client 
software.

Preparing to use Group Policy: Group Policy deployment 
considerations

If you use Group Policy to deploy the printer and PrintWhere software, you can deploy 
with Group Policy in one of two ways:

• deploying based on computer name
• deploying based on user profiles
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Typically, computer-based deployment is recommended. Computer-based deployment is 
faster and easier to manage; the software is deployed only once, and all users who log into 
the computer automatically user that print configuration. 

User-based deployment is easier to set up, but is less efficient. User-based deployments 
are deployed each time a new user logs into a computer, even if the files and software 
were previously deployed to that machine when a different user logged in. 

You’ll need to decide which of these strategies works best for your situation. 

Active Directory prerequisites
User-based deployment relies on Active Directory accounts to distribute software to users. 
To successfully deploy PrintWhere and any printer drivers you might require, you first 
need to ensure that you have:

• Set up and configured your Active Directory with the appropriate domains and 
users, etc.

• Added all PCs to Active Directory, and assigned them to specific groups.
• Created a group in Active Directory for Software, and assigned users and 

computers as members of this group. 

This guide proceeds through the remaining deployment tasks under the assumption that 
the above tasks have been completed.
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Availability of files to be deployed to users
The deployment tasks documented in this guide require you to have your administrator 
computer properly set up, with access to the files you are deploying. These tasks assume 
that the following files are already present and available locally on the Administrator’s 
computer:

File Description
Printer driver and 
Printer

PrintWhere installs a number of generic printer drivers that perform 
very well with most printers on the market. However, if you prefer to 
use a specific printer driver designed specifically for a particular 
printer, you can. The printer driver must be installed on the 
administration computer, and the associated printer added to the list 
of printers. 

• For information on adding the printer driver and printer to the 
administration computer, see Adding your printer and printer 
driver to your Windows Server.

• For information on deploying the printer driver and printer to 
users, see Deploying your printer driver using Group Policy.

Note:  Microsoft Intune does not support deploying printer drivers; 
you can only deploy .msi and .exe files. To deploy a printer driver, you 
must use Group Policy. 

PrintWhere installer PrinterOn offers several PrintWhere .msi installer files, depending on 
whether you want to install PrintWhere or PrintWhere LE (a light 
edition that does not include any default printer drivers), and 
whether you are installing on 64-bit or 32-bit machines. You can 
download your preferred installer file from PrinterOn.com/support/
downloads.html. 

• For information on deploying this file using Microsoft Intune, 
see Deploying and installing PrintWhere using Intune. 

• For information on deploying this file using Windows Group 
Policy, see Deploying and installing PrintWhere using Group 
Policy

• For information on running this file from the command line on 
the target computer, see Installing PrintWhere from the 
command line. 

https://printeron.com/support/downloads.html
https://printeron.com/support/downloads.html
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Adding your printer and printer driver to your Windows Server
Unless you install PrintWhere LE, PrintWhere includes a number of universal printer drivers 
that work with virtually every printer. However, if your organization requires users to use a 
specific printer driver other than the PrintWhere defaults, you’ll need to add that driver 
and the associated printer to your server in order to distribute it to your users. 

ExternalConfig.xml This file is the PrintWhere configuration file, in which you can 
pre-define printer lists for users, preset search filters, set the service 
URL where PrintWhere searches for printers, and configure other 
settings. You’ll need to create this XML file manually and include it 
among your deployed files. 

• For information on creating this file, see Creating a PrintWhere 
configuration file. 

• For information on deploying this file using Microsoft Intune, 
see Deploying and installing PrintWhere using Intune. 

• For information on deploying this file using Windows Group 
Policy, see Deploying and installing PrintWhere using Group 
Policy.

installplugin.ps1 To dynamically provide access to different printer drivers on 
Windows, PrintWhere uses printer plugins, helper printer objects that 
allow the computer to access the required printer driver as needed. 
Typically, PrintWhere downloads and installs these plugins as 
needed. However, in some organizations, users don’t have the 
required privileges to install software. In these cases, you can use a 
PowerShell script provided by PrinterOn to pre-install the required 
plugins on users’ computers. 

• For more information on when and why you would deploy this 
file, see Managing PrintWhere plugins.

• For information on deploying this file using Microsoft Intune, 
see Deploying and installing PrintWhere using Intune. 

• For information on deploying this file using Windows Group 
Policy, see Deploying and installing PrintWhere using Group 
Policy.

File Description

Note:  If the printer and driver already exist on the administration server, you can skip this task. 
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To add a printer driver to the server:
1. In the Server Manager, from the Tools menu, select Print Management.
2. In Print Management navigation pane, expand Print Servers, then click the local 

Print Server > Drivers. 

3. Right-click Drivers and select Add Driver. The Add Printer Driver wizard appears. 
4. Follow the directions in the wizard to add your preferred printer driver.
5. In the left navigation pane, under the local Print Server, right-click Printers and 

select Add Printer. 
6. Follow the directions in the wizard to add your preferred printer.

Next steps
Once you have prepared your server and determined which deployment tools and 
strategies you’ll use, you can continue on to the following tasks:

1. Deploy a printer driver to users. This step is optional, and is only required if your 
organization needs to use a specific printer driver rather that one of the generic 
printer drivers installed with PrintWhere, or you installed PrintWhere LE. 

2. With any specific printer drivers deployed as necessary, you can now prepare the 
deployment script for PrintWhere software itself:
• Deploy PrintWhere and the PrintWhere configuration to users using Microsoft 

Intune. 
• Deploy PrintWhere and the PrintWhere configuration to users using Windows 

Group Policy. 
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Deploying your printer driver using 
Group Policy

PrintWhere includes a number of universal printer drivers that work with virtually every 
printer. However, if your organization requires users to use a specific printer driver other 
than the PrintWhere defaults, you’ll need to distribute that driver and the associated 
printer definition to your users. 

Deploying your printer driver with Group Policy
To deploy a printer driver with Group Policy, complete the following tasks:

• Create a Group Policy Object for printers. 
• Configure the printer deployment. 
• Associate your printer definition with the Group Policy Object.

Note:  
• Microsoft Intune does not support deploying printer drivers; you can only deploy .msi and 

.exe files. To deploy a printer driver, you must use Group Policy. 
• Before beginning these tasks, make sure that the printer driver and printer definition have 

already been added to the server. 



Deploying your printer driver using Group Policy

PrinterOn PrintWhere v6.3.9 Administator Guide |  14

Creating a Group Policy Object for printers
To ensure that the printer is deployed to the correct users, you’ll need to create one or 
more Group Policy Objects (GPOs) for printers. 

This task demonstrates how to create a single GPO called Printers. 

To create a group policy for printers:
1. In the Server Manager, click Group Policy Management. The Group Policy 

Management console appears. 
2. Expand Forest > Domains, then right-click on the domain and select Create a GPO 

in this domain, and Link it here. 

3. In the New GPO dialog, enter Printers as the name of the GPO, then click OK.
The Printers GPO is added to the list of objects in the selected domain. 

4. In the navigation pane, click the Printers GPO. The right pane displays 
configuration information for the GPO. 
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5. In the Scope tab, in the Security Filtering section, add the Groups, Users, and 
Computers to which this Group Policy Object applies.

6. Right-click on the Printers GPO and check Enforced. 

With the Group Policy Object created, you need to edit the GPO to define how the printer 
is deployed. 

Configuring the printer deployment
Once the GPO is created, you need to define how the printer is installed on the users 
computer. How you define this information differs based on whether you decide to deploy 
to computers or to users. 

To configure how the printer is deployed:
1. In the Navigation pane of the Group Policy Management window, right-click 

Printers and select Edit. The Group Policy Management Editor appears. 

2. Complete the policy settings for your deployment type:
• Configure computer-based deployments 
• Configure user-based deployments 

Once the printer deployment information is configured, you can associate the printer with 
the Printers Group Policy Object. 
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Configuring a computer-based deployment

If you are defining a computer-based deployment, you’ll need to configure policy settings 
specific to this deployment type.

To edit the computer-based group policy settings:
1. Right-click the Printer Group Policy Object and select Edit. The Group Policy 

Management Editor appears. 
2. In the navigation pane, open Computer Configuration > Policies > 

Administrative Templates > Printers. 

3. In the right pane, right-click Point and Print Restrictions. and select Edit. The Point 
and Print Restrictions settings appear. 
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4. Select Enabled. 
5. In the Options, specify the fully qualified name of the printer server. If you have 

multiple print servers, separate them with semi-colons. 
6. In the Security Prompts section, for both settings, choose Do not show warning 

or elevation prompt. 
7. Click OK. 

Configuring a user-based deployment

If you are defining a user-based deployment, you’ll need to configure policy settings 
specific to this deployment type.

To edit the user-based Group Policy settings:
1. In the navigation pane, open User Configuration > Preferences > Control Panels. 
2. In the right pane, right-click Printers then select New > Shared Printer. The New 

Shared Printer Properties dialog appears. 

3. In the Action drop-down, select Update. 
4. In the Share Path field, enter the printer location and share name that the user’s 

computer will use to connect to the printer. For example:
\\PrintServer\SharedPrinter

5. Check Set this printer as the default printer. 
6. Click OK. 
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Associating the printer with your Group Policy Object
To deploy the printer driver, you deploy the printer definition by associating it with a 
Group Policy Object, and the printer driver is deployed along with it. 

To associate the printer with the Group Policy Object:
1. In the Server Manager, from the Tools menu, select Print Management.
2. In the Print Management navigation pane, click Printers. The right pane displays a 

list of printers associated with the local print server. 
3. Right-click the printer you want to deploy and select Deploy with Group Policy. 

4. In the Deploy with Group Policy dialog, click Browse... and select Printers Group 
Policy Object that you previously created.

5. Once the Group Policy Object is selected, choose how you want to deploy the 
printer connection:
• The users that this GPO applies to (per user)
• The computers that this GPO applies to (per machine)

6. Repeat Steps 3 and 4 to add additional Group Policy Objects to the deployment 
model, if necessary. 

7. Click OK. 
8. In the Print Management navigation pane, click Deployed Printers and verify that 

the printer driver was successfully added to the list. 
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Next steps
With the required specific printer drivers deployed as necessary, you can now:

• Deploy PrintWhere and the PrintWhere configuration to users using Microsoft 
Intune. 

• Deploy PrintWhere and the PrintWhere configuration to users using Windows 
Group Policy. 
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Deploying and installing PrintWhere 
using Intune

Administrators can use Microsoft Intune to deploy a PrintWhere installer to user’s 
computer which will silently install the PrintWhere software when the user logs in. No user 
intervention is required. 

If you choose, you can also deploy a configuration file called ExternalConfig.xml to pre-
configure the PrintWhere software. You must manually create this file before you can 
begin the deployment process. 

To deploy PrintWhere with Intune, complete the following tasks:
1. Save the required deployment files in a single staging directory. 
2. Create the deployment package.
3. Add the deployment package to Intune. 

Staging the deployment files
The first step in the deployment process is to prepare the files needed to successfully 
deploy and configure PrintWhere using Intune. These files must be stored in a single 
staging folder. 

In addition to the PrintWhere installer and the ExternalConfig.xml file, there are a number 
of helper files and scripts you’ll require to perform various tasks on the user’s machine. 
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To stage the files:
1. Create a staging folder in a location that is accessible to your administrator 

machine. 
2. Download the PrintWhere installer from printeron.com and copy it to your staging 

folder. The PrintWhere installer is an .msi file. Choose the 32- or 64-version as 
appropriate. 

3. Download the following file from PrinterOn and extract the contents to your 
staging folder:

dl.printeron.com/pwc/pwc_intune.zip
This zip file contains several utility files you’ll need to deploy PrintWhere:
• ExternalConfig.xml: A sample PrintWhere configuration file. Replace the 

sample with an existing configuration file, or modify the sample. For more 
information, see Creating a PrintWhere configuration file.

• pwcExternalConfig.cmd: A small batch script file used to copy the 
configuration file to the correct location on the user’s machine. 

• installplugin.ps1: A PowerShell script used to automatically load the necessary 
PrintWhere plugins on the user’s computer. These plugins are used by 
PrintWhere to allow the computer to access the required printer driver as 
needed. 

• main.bat: A script required by Intune to organize and run the post installation 
tasks. 

• del.bat: A script required by Intune to uninstall PrintWhere from the user’s 
computer. 

4. From Microsoft, download the PsExec utility. This utility allows you to run 
commands on remote computers and is called by the main.bat script to execute 
the installer and other scripts. 
a) Download and extract the following file:

PSTools.zip
This zip file contains a number of utilities. 

b) Select the PsExec64.exe file (or PsExec.exe if your deploying to 32-bit 
machines) and copy it to your staging folder. 

With the deployment files staged, you can now create a deployment package. 

Note:  For more information on plugins, why you need to pre-install them, and 
prerequisites and requirements, see Managing PrintWhere plugins. 

https://www.printeron.com/printwhere-msi-downloads.html
http://dl.printeron.com/pwc/pwc_intune.zip
https://download.sysinternals.com/files/PSTools.zip
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Creating an .intunewin deployment package
To create the .intunewin file:

1. From Microsoft, download the Content Prep tool. This tool is a command line 
utility that takes the files in the staging folder and packages them into a single 
To get the tool:
a) In your browser, go to the following location:

https://github.com/microsoft/Microsoft-Win32-Content-Prep-Tool
b) Click Clone or Download, then click Download ZIP.
c) Extract the files. 

2. In the folder where you extracted the files, double-click IntuneWinAppUtil.exe. 
3. A command prompt will open, prompting you to specify the source folder. Type 

the full path to your staging folder, then press the Enter key. 
4. For the name of the setup file, type main.bat, then press Enter. 
5. For the output folder, type the location where the deployment package will be 

placed, then press Enter. 
6. Type n to specify no catalog folder, then press Enter. 

The utility will package all the files from the source folder and create a file called 
main.intunewin. You can now add this app to Intune and define the deployment 
parameters. 

Adding the deployment package to Intune
To add the app to Intune:

1. Launch the Intune portal at devicemanagement.microsoft.com. 
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2. In the left navigation, click Apps > All Apps, then click Add. 
.

3. On the Select App Type page, scroll to the bottom of the list and select Windows 
app (Win32), then click Select. The App information screen appears. This screen is 
the first of many that guide you through the process of adding an app to Intune. 
Initially, this screen is empty except for a link that allows you to select the package 
you wish to add. 

4. To begin the process, complete the following steps:
a) Click Select app package file in the App Information screen. The App package 

file dialog appears. 
b) In the App package file dialog, browse to the location where you saved your 

main.intunewin file.
c) Click OK. 

The App Information screen appears, now populated with configuration fields. You can 
now go through the series of screens to configure the information required to deploy the 
app to users. 
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App information screen: Providing PrintWhere details 
The App information screen lets you provide some basic information about the 
PrintWhere client. 

To configure app information. 
1. In the App information screen, configure the following settings: 

You can configure the remaining fields if you wish, but they are not necessary. 
2. Click Next to display the Program screen.

Setting Description
Name Enter PrintWhere. If you have a corporate Intune portal, this is the 

name that is displayed. 
Description A description of the PrintWhere app. Enter a useful description, as 

this value may be seen by the user. If you have a corporate Intune 
portal, this description is displayed with the app. 

Publisher Enter PrinterOn. 
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Programs screen: Defining deployment behaviors
The Program screen lets you define the install and uninstall scripts. 

To define deployment behavior:
1. In the Program screen, configure the following settings. 

2. Click Next to display the Requirements screen.

Field Description
Install Command Enter main.bat. 
Uninstall command Enter del.bat. 
Install behavior Select System to allow the Microsoft Intune Management 

Extension to run the install and uninstall commands on the 
user’s computer at the system level. 
Note:  If the Microsoft Intune Management Extension is not 
present on the user’s system, it installed automatically.

Device restart 
behavior

Defines the restart behavior after an app installation. 
The default value, App install may force restart, should be 
sufficient. This setting allows the app to complete without 
suppressing restarts. Typically, a restart is unnecessary after 
installing PrintWhere. 
If you want to force a restart after installation, select Intune will 
force a mandatory restart.
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Requirements screen: Defining software requirements
The Requirements screen lets you set any software requirements that must be met before 
Intune will attempt to install the software. 

To define the PrintWhere requirements:
1. In the Requirements screen, configure the following settings: 

2. Click Next to display the Detection rules screen.

Field Description
Operating system 
architecture

Choose either 32-bit or 64-bit.

Minimum operating 
system

Choose Windows 10 1607. 
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Detection rules screen: Defining detection rules
Detection rules allow Intune to determine whether PrintWhere is already installed on the 
user’s computer. 

To define a detection rule:
1. In the Rules Format drop-down, select Manually configure detection rules. 
2. Click Add. The Detection Rule panel appears. 
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3. From the Rule Type drop-down, select Registry, then configure the rest of the 
fields that appear as follows. 

4. Click OK to return to the Detection Rules screen.
5. Click Next to display the dependencies screen. 

Dependencies screen: Defining dependencies
The dependencies screen lets you define any software that the deployed app depends 
upon. PrintWhere has no dependencies. 

Click Next to display the Assignments screen.

Field Description
Key path Enter the path to PrintWhere in the Windows Registry:

Computer\HKEY_LOCAL_MACHINE\SOFTWARE\PrinterOn 
Corporation\PrintWhere 6.2

Value name Enter Build.
Detection method Select String comparison.
Operator Select Equals.
Value Select the build number of the PrintWhere software. To find the 

build number:
1. Locate the PrintWhere.msi file in File Manger, then right-

click and select Properties.
2. In the Properties dialog, open the Details tab.
3. Locate the Subject property. This value shows the 

PrintWhere build number (for example, 6.2.6.2112). 
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Assignments screen: Assigning PrintWhere to one or more groups
The Assignments screen lets you assign PrintWhere to one or more user groups. 
Assignment groups essentially allow you to define to make the software available to a 
whole set of users. An assignment can be made in one of three assignement types:

• Required: The app is installed on devices in the selected groups.
• Available for enrolled devices: The app is not installed automatically on the 

devices in the selected groups. However, the app is made available on the 
Company Portal app or Company Portal website for users in the selected 
groups to install themselves.

• Unsintall: The app is removed from all devices in the selected groups. 

To assign the PrintWhere deployment package to a group:
1. In one of the assignment types, click Add group and assign the groups to which 

you want to deploy PrintWhere.
2. In the Select groups pane, select one or more groups to assign the PrintWhere 

deployment package to.
3. Click Select. 
4. If necessary, click any of the values in a row to open the edit assignment panel. The 

panel lets you configure the delivery settings by modifying the End user 
notifications, Availability, and Installation deadline settings. You can also remove 
a group from the list of groups that will receive the PrintWhere app. 
Click OK after you have finished making changes.

5. Click Next to display the Review + create page. 
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Review + create screen: Reviewing your deployment configuration
The Review + create screen lets you can review your deployment settings. 

Review the values and perform one of the following:
• To make any changes you your settings, click Previous to return a previous screen 

and make changes. 
• To confirm your settings and add the app to Intune, click Create. 

With PrintWhere added, Intune will begin to deploy the app to your organization based 
on the deployment settings you defined. 
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5 

Deploying and installing PrintWhere 
using Group Policy

Administrators can use Windows Group Policy deploy a PrintWhere installer to user’s 
computer which will silently install the PrintWhere software when the user logs in. No user 
intervention is required. 

If you choose, you can also deploy a configuration file to pre-configure the PrintWhere 
software.

To deploy PrintWhere with Group Policy, you’ll need to complete the following tasks:
• Create a Group Policy Object for the PrintWhere software. 
• Configure the PrintWhere deployment. 
• Configure the PrintWhere configuration deployment.

Note:  Before you begin, make sure you have:
• Downloaded the PrintWhere installer file(s) to a location that is accessible to 

the administration computer. 
• Created your external PrintWhere configuration file (if you intend to deploy 

one) and saved it in the same folder as the installer(s). 

https://printeron.com/support/downloads.html
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Creating the Group Policy Object for the PrintWhere software
To ensure that the PrintWhere software and configuration file are deployed correctly for 
your users, you’ll need to create a Group Policy Object (GPO) for each group of users that 
requires a unique PrintWhere configuration. 

This task demonstrates how to create a single GPO called Software. The series of tasks that 
follow will all use this group policy. If you choose, you can create separate GPOs for each 
task. 

To create a new Group Policy Object for PrintWhere:
1. In the Server Manager, click Group Policy Management. The Group Policy 

Management console appears. 
2. Expand Forest > Domains, then right-click on the domain and select Create a GPO 

in this domain, and Link it here. 

3. In the New GPO dialog, enter Software as the name of the GPO, then click OK.
The Software GPO is added to the list of objects in the selected domain. 
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4. In the navigation pane, click Software. The right pane displays configuration 
information for the GPO. 

5. In the Scope tab, in the Security Filtering section, add the Groups, Users, and 
Computers to which this Group Policy Object applies.

6. Right-click on the Software GPO and check Enforced. 

With the Group Policy Object created, you need to edit the GPO to configure how the 
PrintWhere software is deployed.

Configuring the PrintWhere deployment
Once the GPO is created, you need deploy the PrintWhere installer file, then instruct the 
user’s computer to install the file. 

To configure how PrintWhere is deployed:
1. In the Group Policy Management window, right-click on the Software GPO and 

select Edit. The Group Policy Management Editor appears. 

2. In the Navigation pane, open Computer Configuration > Preferences > Windows 
Settings. 
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3. In the right pane, right-click Files, then select New > File. The New File dialog 
appears. 

4. Configure the settings as follows:

5. Click OK. 
6. In the Navigation pane, open Computer Configuration > Software Settings. 
7. Right-click Software Installation then select New > Package. 
8. In the Open dialog, browse to the location the PrintWhere installer was placed, 

then select the file and click Open. The Deploy Software dialog appears. 
9. In the Deploy Software dialog, select Assigned as the deployment method. This 

deployment method instructs the user’s computer to execute the installer and 
install the PrintWhere software. 

Setting Description
Action Select Update. 
Source file(s) Specify the location where you saved the PrintWhere .msi file. 
Destination file Specify where the .msi file will be placed. This location must be 

accessible to every user’s computer; for simplicity, it is 
recommended to simply install it in a folder on the user’s 
computer.

Read-only Enable this attribute. 
Archive Enable this attribute. 
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10. Click OK.

With he PrintWhere installer deployed and configured to be installed, you can now deploy 
the PrintWhere configuration file, if you choose to. 

Deploying the PrintWhere configuration through Group Policy
To deploy a PrintWhere configuration to users through group policy, you need to deploy 
two separate files:

• ExternalConfig.xml: This file is the PrintWhere configuration file, in which you can 
pre-define printer lists for users, preset search filters, set the service URL where 
PrintWhere searches for printers, and configure other settings. You’ll need to 
create this XML file manually. 
• For information on creating this file, see Creating a PrintWhere configuration 

file. 
• For information on deploying this file, see Deploying the ExternalConfig.xml 

file. 
• installplugin.ps1: This PowerShell script automatically loads the necessary 

PrintWhere plugins on the user’s computer. These plugins are used by PrintWhere 
to allow the computer to access the required printer driver as needed. 
• For more information on plugins and why need to pre-install them, see 

Managing PrintWhere plugins
• For information on downloading and deploying this file, see Pre-installing the 

PrintWhere plugins.

Notes for deployment:
The order in which these files are deployed to users is very important. The configuration file 
must be deployed and installed before the plugin installer script. 
In addition, the end user must reboot their computer after the configuration file is deployed and 
before the plugin installer script is deployed. 
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Deploying the ExternalConfig.xml file

Before beginning this task, ensure that you have a valid ExternalConfig.xml file already 
created and available from an accessible location. 

To deploy the PrintWhere configuration file:
1. In the Group Policy Management window, right-click on the Software GPO and 

select Edit. The Group Policy Management Editor appears. 

2. In the Navigation pane, open User Configuration > Preferences > Windows 
Settings. 

3. In the right pane, right-click Files, then select New > File. The New File Properties 
dialog appears. 

Important!  To correctly install the PrintWhere plugins, the ExternalConfig.xml file must define 
every printer that you want the user to be able to access as a default printer. The 
InstallPlugins.ps1 script reads this list to determine which plugins to install. For more 
information, see Managing PrintWhere plugins.
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4. Configure the settings as follows:

5. Click OK. 

Pre-installing the PrintWhere plugins 

To deploy the PowerShell script:
1. Download and extract the PowerShell script file from PrinterOn:

dl.printeron.com/pwc/installplugin.zip

Setting Description
Action Select Update. 
Source file(s) Specify the location where you saved the PrintWhere 

configuration file (ExternalConfig.xml).
Destination file Specify where the configuration file will be placed. This file must 

be placed in the following locations on every user’s machine:
• C:\Users\<user_name>\AppData\Local\PrinterOn 

Corporation\PrintWhere 
<version>\Config\ExternalConfig.xml

• C:\Windows\System32\config\systemprofile\AppData\Local\
PrinterOn Corporation\PrintWhere 
<version>\Config\ExternalConfig.xml

Read-only Enable this attribute. 
Archive Enable this attribute. 

Note:  This URL is case-sensitive.

http://dl.printeron.com/pwc/installplugin.zip
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2. Once the script file is extracted, return to the Group Policy Management window, 
then, right-click on the Software GPO and select Edit. The Group Policy 
Management Editor appears. 

3. In the Navigation pane, open Computer Configuration > Preferences > Control 
Panel Settings. 

4. Right-click Scheduled Tasks and click New > Scheduled Task. The Task Scheduler 
dialog appears. 
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5. In the General tab of the dialog, configure the following settings:

6. Click the Actions tab, then click New.... The New Action dialog appears. 

7. In the New Action dialog, configure the following settings:

Setting Description
Action Select Create. 
Name Specify a unique name for the task. 
Security Options Configure the following settings:

• Configure the action to run as System. 
• Select Run whether the user is logged on or not. 
• Enable Run with highest privileges. 

Configure for Select the combination of Windows client and server OS that 
you want to support. 

Setting Description
Action Select Start a program. 
Program/script Specify the path to Windows PowerShell. For example:

C:\Windows\System32\WindowsPowerShell\v1.0\powershell.exe

Add arguments Define the following arguments for the command:
-ExecutionPolicy Bypass 

-command "&\\PRINTSERVER\pw\installplugin.ps1" 
-PluginCacheEnabled "true"
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8. Click the Settings tab, then specify the scheduling settings as necessary. 

9. Click OK. 
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A 

Configuring PrinterOn for use with 
PrintWhere: Best practices

Deploying PrintWhere to your users with Intune or Group Policy ensures that every user is 
set up with the printing environment that you want them to have. However, to take full 
advantage of all the benefits that PrintWhere offers, there are a few best practices you 
should follow when configuring your PrinterOn Server.

Best practice: Configure two output destinations for a printer 
listing

When you create a new PrinterOn printer listing, one of the settings your required to 
define is the output destination—that is, the network path to the physical printer that the 
listing represents. Typically a printer listing is configured with a single output destination. 

However, one of the key benefits of using PrintWhere in your Windows environment is its 
ability to connect to a printer using two different network paths. The Smart Print Path 
feature of PrintWhere automatically picks the best print path (shortest, fastest, and least 
costly) and compresses files for up to 75% bandwidth savings and faster print.

Smart Print Path is an extremely useful feature for modern mobile workforces, where users 
may at times be connected to the internal, firewall-protected network, or to some external 
network.



PrinterOn PrintWhere v6.3.9 Administator Guide |  42

Because users mobile, they may at times be connected to either the internal network 
behind the firewall, or to some external network. PrintWhere allows you to set up a 
primary path to the printer (used when the user is connected to the local network) and a 
secondary path (used when the user is trying to access the printer remotely). 

The user does not need to change their printer, nor modify any settings; PrintWhere 
makes it seamless. If PrintWhere is unable to connect using the primary path, it 
automatically attempts to connect using the secondary path. 

When configured properly, having two paths to the printer can not only optimize network 
usage, but can also improve the performance of your PrinterOn service. To maximize the 
potential benefits, you must define your primary and secondary paths appropriately.

Determining the primary path routing
The primary path is used when the user is connected to the local network. For optimal 
performance, you should configure the primary path as a direct connection using either 
the IPP or TCP protocol. A direct connection routes print data directly from the user’s 
computer to the printer, without sending it through the PrinterOn infrastructure. 

Print data can be large (the PrinterOn service supports jobs of up to 50MB). a direct 
connection reduces the number of times this data is transferred, improving performance 
considerably. 

Choosing IPP or TCP

The PrinterOn service supports two protocols, TCP and IPP, that can be used to 
communicate directly with the printer. Which protocol you should use depends largely on 
the printer. 

• TCP protocol: TCP is one of the earliest Internet communication protocols. Every 
printer supports TCP. However, its wide support among printers is TCP’s primary 
advantage; it does not support compression or encryption of data, and does not 
return print job status information. 
Use the TCP protocol only if you have an older legacy printer, or if you can’t 
determine whether your printer supports IPP. 

Note:  Although the print data bypasses the PrinterOn Server, the server still 
collects other job accounting data for each print job. 
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To define a direct network path to the printer using TCP, use the following syntax:
tcp://<IP_address_or_DNS_name>[:<port_number>]

For example:
tcp://172.16.1.1:9100

• IPP Protocol: IPP is built upon TCP and extends it specifically for communicating 
with printers; IPP includes built-in support for encryption, compression, and job 
status information. As a result, IPP is the preferred option, if the printer supports it. 
Use IPP if your printer is AirPrint compatible. AirPrint, Apple’s Printing protocol, 
uses IPP, and is supported by most newer printers. 
To define the path using IPP, use the following syntax:

ipp://<IP_address_or_URI>/<printer_queue>
For example:

ipp://172.16.1.1/ipp/port1

Determining the secondary path routing
The secondary path is used when the user is attempting to print from outside the firewall. 
In this instance, the print data is routed through the PrinterOn Server, which provides a 
communication link through the firewall. The server then directs the data to the printer. 

The secondary path should be configured using HTTP, HTTPS, or some other protocol.

Putting it together: Configuring a printer with two network paths
The output destination is a key part of the PrinterOn printer listing configuration, linking 
the printer listing with the physical printer. You can set the output destination paths using 
the PrinterOn Configuration Manager. 

Note:  Specifying the port is recommended for optimal efficiency. If no port 
is specified, PrintWhere queries up to three ports (443, 80, and 631) to 
determine whether they are open and available for use, which requires an 
additional conversation between PrintWhere and the server. 
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To configure a printer listing with two output destinations:
1. In the Configuration Manager, click Printers. The Printers tab appears, displaying a 

list of currently available printers.

2. In the PrinterOn Printers list, click  next to a printer that you want to configure. 
The printer actions appear. 

3. Click Configure. The Printer Configuration dialog appears. 

4. In the Printer Configuration dialog, expand the Output Location section
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5. Set your Primary path to the printer in the Output Destination field. This should 
be a direct connection to the printer, and should use either the IPP or TCP 
protocol. 

6. Disable Allow Printing Directly to PDS. 
7. Disable Print Directly to PDS Only. 
8. Check Use An Alternate/Local Print Delivery Hub to Host Print Jobs. An 

additional field, Server Address, appears. 
9. Set your Secondary path to the printer in the Server Address field. 
10. When you have finished modifying the printer configuration, click Apply Settings.

Note:  If you’re using TCP, specifying the port is recommended for optimal performance. 
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B 

Creating a PrintWhere conf iguration 
f ile

With external configuration, administrators can pre-define printer lists for users, preset 
search filters, set the service URL where PrintWhere searches for printers, and configure 
other settings. The first time PrintWhere is started, the options from the external 
configuration are loaded, so users can print with no setup at all. 

External configuration of PrintWhere also allows administrators to centrally manage 
PrintWhere behavior and provide a consistent experience for all users. 

When PrintWhere is configured for them, users can still access the PrintWhere Printer 
Manager and Printer Properties dialogs. If users change the PrintWhere configuration, 
PrintWhere checks to see if an XML configuration file exists, and if so, saves any changes 
made by the user to the external configuration. 

Administrators can also lock the PrintWhere configuration, so that users cannot change it 
at all.
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Creating an XML configuration file
You can create an XML configuration file for PrintWhere that you can distribute to users. 

The XML file must be named ExternalConfig.xml, and it must be deployed to the following 
location on the user’s computer:

C:\Users\<user_name>\AppData\Local\PrinterOn Corporation\Printwhere 
<version>\Config\ExternalConfig.xml

External XML Example

The following sample XML shows the structure of the XML configuration file. For details 
about each of the settings, see External configuration settings reference.
<?xml version="1.0" encoding="UTF-16" standalone="yes"?>
<pwcProperties propertiesVersion="1.0">

<search enabled="1">
<searchOrgName userEdit="1"/>
<searchAddress userEdit="1"/>
<siteNumberList use="optional"/>

</search>
<printerChooser sysTrayAndStartup="1" userEdit="1"/>
<webServiceManagerURI/>
<DefaultPrinterList/>
<lockPrinterConfig>0</lockPrinterConfig>
<AuthenticationMode>0</AuthenticationMode>
<AskForCredentialsAlways>0</AskForCredentialsAlways>
<OAuthBrowserTimeout>120</OAuthBrowserTimeout>
<serviceURL>secure1.printeron.net</serviceURL>
<siteID/>
<clientUID/>
<sessionMetaData/>
<OptionShowWinPrinters>1</OptionShowWinPrinters>
<SearchUsingPrivateURL>1</SearchUsingPrivateURL>
<SearchCategory>All</SearchCategory>
<PrimarySite>www.printeron.com</PrimarySite>

</pwcProperties>

Note:  The ExternalConfig.xml file must be encoded as Unicode.
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Creating a PrintWhere Windows Registry key
Registry configuration can be managed for individual users using their standard Windows 
user profile locations. 

The PrintWhere Registry configuration information should be put into the users Current 
User registry hive, at the following location:

HKEY_CURRENT_USER\Software\PrinterOn Corporation\PrintWhere 
<version>\ExternalConfig

Sample Registry 

The following sample the structure of the PrintWhere configuration in the Windows 
registry. For details about each of the settings, see External configuration settings 
reference.
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External configuration priority
PrintWhere external configuration can be used alongside the Control Panel configuration 
options. However, only one external configuration method can be used at a time. You 
cannot use an XML configuration and Registry configuration at the same time.

Each time PrintWhere is launched, it checks to see if an external configuration exists, and 
if found, loads the specified configuration settings. PrintWhere first checks to see if 
ExternalConfig.xml exists. If the file is not found, it then checks for a PrintWhere entry in 
the Windows registry. 

Upgrading an external configuration

PrintWhere supports external configuration upgrade. Older versions of PrintWhere will 
also be migrated from previous configuration locations in the registry to the new XML file 
format to support a forward migration to the new method.

If no external configuration exists, PrintWhere uses default values. 

External configuration settings reference
The following sections outline the external configuration settings and permitted values. 

• AskForCredentialsAlways
• AuthenticationMode
• DefaultPrinter
• LockPrinterConfig
• OAuthBrowserTimeout
• PrimarySite
• PrinterChooser
• RemovePrinter
• Search settings
• Server-side encryption (available only as a registry entry)
• ServiceURL
• Third-party integration settings
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AskForCredentialsAlways

AuthenticationMode

Description Specifies whether the user must provide their credentials each time they 
close or minimize the Printer chooser. 

 XML Syntax <AskForCredentialsAlways>

value

</AskForCredentialsAlways>

Registry Entry AskForCredentialsAlways value

Values value can be one of:
0: Default. PrinterOn asks for credentials once, and then saves them. 

PrinterOn does not ask for credentials again. 
1: When the user logs off, PrintWhere clears credentials. The next time they 

print or access Printer Manager, PrintWhere prompts the user for their 
credentials. This value only applies with AuthenticationMode is set to a 
value of 2 or 3. 

Description Specifies the authentication mode used. 
 XML Syntax <AuthenticationMode>

value

</AuthenticationMode>

Registry Entry AuthenticationMode value

Values value can be one of:
0: Default. PrintWhere does not prompt the user for their credentials, but 

passes on the credentials specified PrintWhere’s Account Settings 
dialog, when required. 
If the user does not provide their credentials in the Account Settings 
dialog, but the PrinterOn server is configured to use either LDAP/AD or 
Azure AD for authentication, the user will not be authenticated and all 
print requests are rejected. 

1: Windows authentication is used (either the local user account, or the 
administrator credentials, if logged in as administrator). 

2: The LDAP/AD or Azure AD account credentials are used. 
3: Only the PrinterOn account username is used. 
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DefaultPrinter

LockPrinterConfig

Description Specifies a list of Default Printers. The first member of the list will be the 
default selected one when you use the PrinterChooser. Additional printers 
listed will be available from the Printer drop-down list in the PrintWhere 
Properties dialog.

Printers are displayed in the Printer Manager’s History list in the order they 
are listed. 

Important! You must select at least one default printer. 
 XML Syntax <DefaultPrinterList>

<DefaultPrinter>printer1</DefaultPrinter>

<DefaultPrinter>printer2</DefaultPrinter>

</DefaultPrinterList>

Registry Entry DefaultPrinter printer1,printer2,...

Note: Multiple printers can be defined in a comma-separated list. 
Values printer represents the PrinterOn printer name or printer number. 

Description Specifies whether the printer configuration can be modified by users. 
 XML Syntax <lockPrinterConfig>

value

</lockPrinterConfig>

Registry Entry LockPrinterConfig value

Values value can be one of:
0: Default. The user can modify the printer configuration.
1: The Printer configuration is locked and cannot be modified.
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OAuthBrowserTimeout

PrimarySite

Description Specifies the length of time PrintWhere waits for the user to authenticate 
against an external third-party authentication service, such as Microsoft 
Azure AD. 

These services require PrintWhere to redirect the user to a URL hosted by the 
service to enter their credentials, during which time PrintWhere remains 
blocked. Because PrintWhere has no control over the browser session, the 
timeout value allows you to provide a finite amount of time before 
PrintWhere assumes the user did not successfully authenticate. 

If PrintWhere does not receive a response that the user is successfully 
authenticated before the timeout, the user is informed that PrintWhere 
could not validate the account, and PrintWhere becomes unblocked. 

The default timeout is two minutes.
 XML Syntax <OAuthBrowserTimeout>

integer

</OAuthBrowserTimeout>

Registry Entries OAuthBrowserTimeout value

Values integer is the length of time, in seconds before PrintWhere aborts the 
authentication process.

The default is 120 seconds.

Description Specifies the site where the PrinterOn license is accessed. This site is also 
used for PrintWhere downloads. This is not the same as the Service URL. 

 XML Syntax <PrimarySite>

string

</PrimarySite>

Registry Entry PrimarySite string

Values string is the URL of the primary site.
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PrinterChooser

RemovePrinter

Description Specify printer chooser settings. You can specify: 
• whether PrintWhere Printer Manager icon is minimized to the system 

tray when closed.
• whether the user can edit the settings in the printer chooser. 

 XML Syntax <printerChooser

sysTrayAndStartup=”sys_value”

userEdit=”edit_value”/>

Registry Entries PrinterChooser_SysTrayAndStartup sys_value
PrinterChooser_UserEdit edit_value

Values sys_value can be one of:
0: The Printer Manager is not minimized to the System Tray.
1: Default. The Printer Manager is minimized to the System Tray.

edit_value can be one of:
0: The user cannot edit the settings.
1: Default. The user can edit the settings.

Description Clears the list of previously selected printers whenever a new Service URL is 
pushed to the user. 

This setting does not affect behavior when the user changes the Service URL 
manually in Printer Manager. 

 XML Syntax <RemovePrinter>

value

</RemovePrinter>

Registry Entry RemovePrinter value

Values value can be one of:
0: The printer list is not modified. Printers are not removed.
1: Default. The user can modify the client UID and session values.
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Search settings

Description Specify whether the user is permitted to search for printers, and defines 
address, category, and organization search filters. If searching is permitted 
and filters are defined, PrintWhere only returns printers that are located at 
the specified address, match the specified category, or belong to the 
specified organization.

You can also specify whether the user is permitted to edit the Search Address 
or Search Organization value.

 XML Syntax <search enabled=”1”>

<searchAddress userEdit=”value”>

addr_string

</searchAddress>

<searchCategory>

cat_string

</searchCategory>

<searchOrganization userEdit=”value”>

org_string

</searchOrganization>

</search>

Registry Entries SearchAddress addr_string
SearchAddress_UserEdit value
SearchCategory cat_string
SearchOrgName org_string
SearchOrgName_UserEdit value

Values addr_string represents any part of an address (state, city, street, zip) defined 
for a printer. 

cat_string is one of the following categories:
• All (default)
• Public
• Organization

org_string represents a company name defined for a printer. 

value can be one of:
0: The user cannot edit the filter value.
1: Default. The user can edit the filter value.
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Server-side encryption

ServiceURL

Description In deployments where AWS is used for storage of print job data, you can 
specify if you want Amazon S3to encrypt your data for you at the time of 
creation. By default, this setting is enabled. 

 XML Syntax This setting cannot be set via the ExternalConfig.xml file. 

Registry Entry RTR_AWS_UseServerSideEncryption value

Values value can be one of:
0: Server-side encryption is not used. 
1: Default. Server-side encryption is used. 

Description Specifies the Service URL, which identifies where the PrinterOn Service is 
hosted. This URL hosts the printer list that PrintWhere searches.

If you specify a Service URL value that points to a service that requires 
credentials, you should modify AuthenticationMode to cause PrintWhere to 
prompt for credentials.

 XML Syntax <serviceURL>

string

</serviceURL>

Registry Entry ServiceURL string

Values string represents the Service URL for your PrinterOn solution. 
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Third-party integration settings

Description The ClientUID, SessionMetaData, and EnableSessionClientUID specify 
information used by some third-party integrations. 

You can also specify whether the user is permitted to edit the client UID and 
session metadata content.

 XML Syntax <clientUID>

string

</clientUID>

<sessionMetaData>

string

</sessionMetaData>

<EnableSessionClientUID>

value

</EnableSessionClientUID>

Registry Entries ClientUID string
SessionMetaData string
EnableSessionClientUID value

Values string represent user information required by your third-party integration. 

value can be one of:
0: The user cannot modify the client UID and session values.
1: Default. The user can modify the client UID and session values.
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C 

Managing PrintWhere plugins

In a typical PrintWhere scenario, where the user has some administration privileges for 
their computer, when a PrintWhere user selects a printer, PrintWhere dynamically 
downloads and installs a small file called a printer plugin. A printer plugin is a helper 
printer object that PrintWhere uses to allow the computer to access the required printer 
driver. 

However, in many organizations, users don’t have the required privileges to allow 
PrintWhere to download and install these files. This presents a problem: Without the 
plugin, a user can search for and locate PrinterOn printers, but they cannot actually print 
to them because the computer cannot access the required driver. 

To work around this limitation, PrinterOn provides a plugin installation script, 
installplugin.ps1. This PowerShell script enables administrators to pre-install the required 
PrintWhere plugins so they are available on the user’s machine when required. 

To retrieve the script, you can download and extract the following zip file:
dl.printeron.com/pwc/installplugin.zip.

Requirements for using the plugin installation script
The installplugin.ps1 file has several requirements:

• PrintWhere configuration prerequisites
• Deployment requirements

http://dl.printeron.com/pwc/installplugin.zip
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PrintWhere configuration prerequisites
The installplugin.ps1 script has the following PrintWhere configuration prerequisites:

• Printers List: Each printer to which the user should have access must be defined as 
a default printer in the PrintWhere configuration. For information about defining a 
list of default printers, see DefaultPrinter in Appendix B: Creating a PrintWhere 
configuration file. 

It is important that you define all of the printers the user can access. Remember that 
without the plugin, the user can still search for and select any printer to which they have 
access; without the plugin, though, they will be unable to send their print job to the 
printer. 

The PowerShell script provided by PrinterOn only installs plugins for those printers 
specified in the default printers list. Therefore, if you don’t define all accessible printers, 
the user will be able to view and select printers that they cannot successfully print to 
because the required plugin will not be available on their computer. 

Deployment requirements
The installplugin.ps1 script has the following deployment requirements prerequisites:

• Order of deployment: Because the plugin installation script reads the 
ExternalConfig.xml file to determine which plugins to download and install on the 
user’s computer, the ExternalConfig.xml file must already be present on the user’s 
computer when the installplugin.ps1 script is deployed.

• Reboot requirement: Before deploying the installplugin.ps1 file to users’ 
computers, users must first reboot their PCs. 

For more information about deploying the installplugin.ps1 file, see: 
• Deploying and installing PrintWhere using Intune. 
• Deploying the PrintWhere configuration through Group Policy
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D 

Configuring PrintWhere for Citrix or 
shared terminal environments

Administrators can deploy PrinterOn in environments where multiple users are accessing 
printing services through a single server or terminal. For example:

• Citrix environments: In these environments, a central Citrix server is used to 
provide employees with remote access to network printers no matter where they 
may be: at the office; at home; or at a public printing location, such as an airport 
or library.

• Shared terminal environments: In these environments (for example, a public 
printing kiosk), a single computer is used to access printing services, but each user 
logs in under their own account. 

In both of these scenarios, installing and configuring the PrintWhere software to access 
the printing infrastructure is essentially the same. 

Using PrinterOn with Citrix
PrinterOn can be used with Citrix in a couple of scenarios:

• In mobile environments, where the Citrix Receiver mobile app is used to access a 
server-based desktop environment, PrinterOn’s network infrastructure can be used 
to deliver the print data across disparate networks. PrinterOn’s PrintWhere driver is 
used to deliver print data from the Citrix server to the remote print location.
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• On Windows desktop computers, PrintWhere provides native File > Print 
capability from any application. Typically, Citrix users are only able to print to 
those printers directly connected to the Citrix server. Through PrintWhere, users 
are able to search for and print to all enabled enterprise printers without being 
connected to the network or having particular print drivers installed. This gives 
employees remote access to enterprise printers no matter where they may be. 

To enable printing from Citrix, administrators must enable employees to access 
PrintWhere from their Citrix sessions. This appendix describes how to provide users with 
the access they need. 

Citrix server configuration
The PrinterOn PrintWhere driver requires the following software:

• Citrix XenApp 6.5 or later
• Windows 2008 r2 x64 or later or Windows 2012 r2 x64 or later

The server is part of a workgroup. PrinterOn services must be installed on a single server. 
PrintWhere is installed for multiple users on the farm node.

In addition, to allow users to access the PrintWhere documentation, you should ensure 
that the Microsoft XPS Viewer is installed on your server. 

Installing PrintWhere in your environment 
To install PrintWhere:

1. Download the PrintWhere installer from the PrinterOn website at 
www.printeron.com/support/downloads.html. 

2. On the farm node, click on Start > All Programs > Accessories. 
3. In the Accessories folder, right-click on Command Prompt, and select Run as 

administrator. 
4. In the Administrator: Command Prompt window, type:

change user /install.
5. From the command prompt, type PWhere.exe to launch the PrintWhere installer.
6. Follow the installation instructions. 

http://www.printeron.com/support/downloads.html
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Configuring the central computer to use PrintWhere
To avoid issues and ensure that users can print, administrators should pre-install the 
necessary printer drivers on the central computer. An administrator should install, 
configure, and print to each device prior enabling users. After the administrator has 
printed once, subsequent users can use the service without additional rights.

Configuring the user’s computers
To ensure that users avoid issues using PrintWhere, administrators must modify the 
Windows Registry on the shared terminal accessed by users, or in a Citrix environment, on 
each user’s computer locally, to complete the following tasks:

• Enable plugin caching 
• Suppress Interactive Service Messages 

Enabling plugin caching
With PrintWhere, when a user changes a destination printer, PrintWhere adds a helper 
printer object to the computer, referred to as a PrintWhere plugin. This plugin provides the 
computer access to the required printer driver. By default, to minimize its presence on the 
computer, PrintWhere uses only one plugin at a time. Whenever a user selects a different 
printer, PrintWhere removes the existing plugin and adds a new one.

To make these changes to the system, PrintWhere requires the user to have permission to 
change printers and set the drivers. If the user does not have permission to install drivers, 
then errors occur that can prevent the user from printing.

Plugin caching allows PrintWhere to maintain multiple plugins so that they don’t need to 
be removed and added every time the user selects a different printer. This approach allows 
users who cannot add new printers to work around their limited permissions. Users can 
move between the printers previously configured by the Administrator, since, from the 
system’s perspective, PrintWhere remains the selected destination printer. 

Note:  A user with administrator privileges MUST install the necessary drivers prior to providing 
the service to users with less privileges. For more information, see Configuring the central 
computer to use PrintWhere.
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To enable plugin caching:
1. Open the Windows Registry Editor and navigate to the following Registry location:

HKEY_LOCAL_MACHINE\Software\PrinterOn Corporation\PrintWhere <version>
2. In the right pane of the registry window, right-click and select New > DWORD 

value. The new value is added to the registry, with the name editable. 
3. Change the value name to PluginCacheEnabled. 

4. Right-click PluginCacheEnabled and click Modify. The Edit DWORD Value dialog 
appears. 

5. Set the Value data to 1. 
6. Close the Registry Editor.

Suppressing Interactive Service Messages
Because PrintWhere plugins appear as a selectable printers, users can accidentally submit 
print jobs to a plugin instead of to the PrintWhere driver itself. When this happens, 
PrintWhere attempts to display a message informing the user that the selected plugin is 
not a valid selection, and to choose the PrintWhere driver instead. 

In rare cases, the print process uses system services, such as the print spooler, to display 
these messages. In cases where users do not have sufficient permissions to see these 
Interactive Service Messages, such as in Citrix environments, the user may not see the 
messages, and printing problems can occur. To avoid issues, administrators can disable 
Interactive Service Messages. 

To disable Interactive Service Messages:
1. Open the Windows Registry Editor and navigate to the following Registry location:

HKEY_LOCAL_MACHINE\Software\PrinterOn Corporation\PrintWhere <version>
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2. In the right pane of the registry window, right-click and select New > DWORD 
value. The new value is added to the registry, with the name editable. 

3. Change the value name to SuppressISM. 

4. Right-click SuppressISM and click Modify. The Edit DWORD Value dialog appears. 

5. Set the Value data to 1. 
6. Close the Registry Editor.
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E 

Installing PrintWhere from the 
command line

In addition to deploying the PrintWhere software remotely using Microsoft Intune or 
Group Policy, you can also manually run the installer from the command line. If you 
include the /q option in the command, no further input is required from the user to 
complete the installation. 

From the command line, you can also uninstall the software. 

Installing the software from the command line
To install the PrintWhere software from the command line:

1. In the Windows Start menu, locate Command Prompt, the right-click and select 
Run as administrator. 

2. On the command line, navigate to the folder containing one of the following 
PrintWhere installation files:
• PWhere_x64.msi
• PWhere_x32.msi
• PWhereLE_x64.msi
• PWhereLE_x32.msi
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3. Type the following command:
msiexec.exe /i “installer_file” /q |INSTALLDIR=”installation_dir” | 

SERVICE_URL=”service_url” | DEFAULT_PRINTER=”printer1,printer2,...” | 

/l*v “log_file_path”

A full description of each option is described below. 

Option Description
/i Required. Installs the specified installer file. For example:

/i “PWhere_x64.msi”

/q Optional. Performs a silent installation of the PrintWhere software. 
The installer UI does not appear, and the user is not prompted for 
any input. 

INSTALLDIR Optional. Specifies a custom installation folder where the PrintWhere 
software will place the PrintWhere software, rather than using the 
default installation folder. For example: 

INSTALLDIR=”C:\\PrintWhere”

SERVICE_URL Optional. Sets the Service URL, which identifies the URL address 
where the PrinterOn service is hosted. PrintWhere communicates 
with the PrinterOn service via this URL. 

This option takes a string as a value. For example: 
SERVICE_URL=”https://123.456.78.90:443/cps

DEFAULT_PRINTER Optional. Specifies a list of predefined printers. Multiple printers can 
be defined in a comma-separated list. For example:

DEFAULT_PRINTER=”900123456789,900123456790”

The first member of the list is used as the default printer, which is 
selected be default in the Printer Chooser. Additional printers listed 
are available to the end user from the Printer drop-down list in the 
PrintWhere Properties dialog. 

Printers are displayed in the PrintWhere software in the order they 
are listed. 

/l*v Optional. When included, the PrintWhere installer generates a log 
file that records the events that occurred during the installation 
process. For example: 

/l*v “C:\PrintWhere\pwhere_log.txt”
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Uninstalling the software from the command line
To uninstall the PrintWhere software:

1. In the Windows Start menu, locate Command Prompt, the right-click and select 
Run as administrator. 

2. On the command line, navigate to the folder containing one of the following 
PrintWhere installation files:
• PWhere_x64.msi
• PWhere_x32.msi
• PWhereLE_x64.msi
• PWhereLE_x32.msi

3. Type the following command:
msiexec.exe /x “installer_file”
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Trademarks and service marks
The following are trademarks or registered trademarks of PrinterOn Inc. in Canada and other countries:

PrinterOn®, PrintAnywhere®, Print Simply Anywhere®, PrintWhere®, PRINTSPOTS®, the PrinterOn 
Logo, the PrinterOn Symbol, PrintConnect™, Secure Release Anywhere™, and PrintValet™ are 
trademarks and/or registered trademarks of PrinterOn.

The following are trademarks or registered trademarks of other companies:

Windows, Internet Explorer, Microsoft Word, Microsoft Excel, Microsoft PowerPoint, and Microsoft Visio 
are trademarks or registered trademarks of Microsoft Corporation. 

iPad, iPhone, AirPrint, and OS X are trademarks or registered trademarks of Apple.

iOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used by 
Apple under license.

Android, Chrome OS, and Chromebook are trademarks or registered trademarks of Google Inc.

BlackBerry is a registered trademark of BlackBerry, Ltd.

Other brands and their products are trademarks or registered trademarks of their respective holders.

Copyright notice
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All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or 
transmitted, in any form or by any means, electronic, mechanical, photocopy, recording, or otherwise, 
without the prior written permission of PrinterOn Inc.

Disclaimer:

PrinterOn Inc. makes no warranty with respect to the adequacy of this documentation, programs, or 
hardware, which it describes for any particular purpose, or with respect to the adequacy to produce 
any particular result. In no event shall PrinterOn Inc. be held liable for special, direct, indirect, or 
consequential damages, losses, costs, charges, claims, demands, or claim for lost profits, fees, or 
expenses of any nature or kind.
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